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1.  INTRODUCTION 

The Kyokushin Management System (KMS) has been developed to aid in tracking many 

aspects of managing a complete organization, with its branches and individual Dojo.  

Initially created as a simple membership enrolment system, KMS was soon re-designed 

and re-developed to assist a Dojo Operator in many aspects of managing a Dojo. KMS 

serves your organization in one homogeneous system, with features to assist HQ, 

Branch Operators and allow Dojo interaction. 

Security and access levels can be defined for each operator to ensure privacy of data. 

Access through public networks (Internet) is only possible using secure network 

connections (SSL) to assure the privacy of data. Required operator identification and 

password prevent unauthorized access to KMS. 

KMS is a flexible system and is maintained to adapt to ever changing needs. 

Functionality of the system will be reviewed regularly. If requirements change, KMS 

features will be adjusted or new features will be implemented. 

 

1 . 1 .  I N S TA L L A T I O N  T Y P E S  

1 . 1 . 1 .  K M S  P R E S E N T A T I O N  C L I E N T  

When using the KMS Presentation Client you will be using a small remote presentation 

client software package, which securely connects to the main KMS server. An active 

Internet connection is required to run KMS, response times are dependent on your 

Internet connection performance, but it is a worry-free type of administration for your 

organization, branch or Dojo. All system maintenance is taken care of.  

1 . 1 . 2 .  K M S  C L I E N T  S Y S T E M  

When using the KMS Client System, you run a restricted copy of KMS. An Internet 

connection is required for some initial set-up operations, but most other operations can 

be done off-line. Your local transactions and updates will automatically be 

synchronized to the main KMS server, whenever a connection can be established. This 

allows Dojo operators to use KMS at locations where no direct network is available, like 

school halls or community halls. 

For set-up instructions of the KMS Client System, please refer to the KMS 

Administrator’s Guide. 

1 . 1 . 3 .  K M S  B R A N C H  S Y S T E M  

A KMSM Branch system is logically situated between one or more KMS Client Systems 

and the main KMS Server. For more information see the KMS Administrator’s Guide.

http://www.kyokushin.nz/
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2.  GETTING STARTED 

2 . 1 .  S Y S T E M  R E Q U I RE M E N T S  

In order to connect and work in KMS you need an Internet connected PC running a 64-

bit version of Windows 10, Windows 11, Windows Server 2016, Windows Server 2019 

or Windows Server 2022. Alternatively a Macintosh with a Windows emulator can be 

used. 

2 . 2 .  O P E R A TO R  I D EN T I F I C A T I O N  

To access KMS you will need an operator identification and password. You can apply for 

these by sending an email request to KMS Support and specify your access 

requirements. If your application is successful you will be given an Operator 

Identification and initial password. On initial login you will be required to change your 

password. 

2 . 3 .  G E T  C O N N E C TED  

If you have not already done so, you need to download the KMS ThinClient (remote 

display) software. Using your favourite Internet browser visit the website 

www.jadesport.com and download the KMS Presentation Client installation package. 

Run this installation package and follow the directions on the screen. 

Click on the KMS Presentation Client shortcut, which will have been created on your 

desktop. This will initiate your first connection to the KMS system. 

 

You are now able to login to the KMS system. Enter your assigned username and initial 

password and familiarize yourself with all aspects of KMS. 

mailto:kyokushin.canterbury@gmail.com?subject=KMS%20Operator%20request
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3. GEOGRAPHICAL SETUP 

After successful login the initial Dojo Manager screen will be displayed as shown below.  

 

The contents of the Dojo Browser may look slightly different; depending on the data in 

the system and the permissions you have been granted.  

 

Clicking the + icon or double-clicking the Organization HQ entry will expand the entry 

and show all available countries. 

http://www.kyokushin.nz/
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3 . 1 .  A D D I N G  A  C O UN T R Y  

To add a Country, open the Dojo Administration form. If your country is not available 

in the Dojo Browser, right-click on the “Organization HQ” icon and select Add 

Country. The Add Country dialog will now be displayed. The left column shows the 

English name for an item, the right column shows the name in your selected language, 

if available. 

 

Let us, for example, add the country of Malaysia. Scroll down to the Malaysia entry and 

select it. Alternatively you can quickly jump to the first entry starting with ‘m’ by 

typing ‘m’ in the Search textbox. If required, multiple countries can be selected. 

Click OK. The dialog will disappear and your newly selected country will have been 

added in the Dojo Browser. 

 

http://www.kyokushin.nz/
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3 . 2 .  A D D I N G  A  C I T Y  

To add a city, open the Dojo Administration Form. In the Dojo Browser expand your 

country selection by clicking your country’s + icon or double-click your country entry. 

If the required city is not available in the Dojo Browser, right-click on your country 

entry and select Add City. The Add City dialog will be displayed. 

 

Let us for this example add the city Kuala Lumpur. Scroll down to the Kuala Lumpur 

entry and select it. Alternatively you can quickly jump to the first entry starting with 

‘k’ by typing ‘k’ in the Search textbox. If required multiple cities can be selected.  

Click OK. The dialog will disappear and your newly created city will have been added in 

the Dojo Browser. 

 

http://www.kyokushin.nz/
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 When selecting your city you will notice that the Dojo Details tab will now be enabled.  

3 . 3 .  A D D I N G  A  R E G I O N  

Regions are used to divide geographical units into other manageable units and can be 

created at any geographical level, using the Dojo Browser of the Dojo Administration 

Form. 

To add a Region, right-click on the geographical unit you wish to divide and select Add 

Region. The Add Region dialog will be displayed.  

 

Ensure the Region Parent is the correct geographical unit, you wish to divide. Then 

enter the name of your new Region and click OK. 

3 . 3 . 1 .  L I N K I N G  A  G E O G R A P H I C A L  U N I T  T O  A  R E G I O N  

After a Region has been created, you are able to link other geographical units into the 

region.  

 

In our example we have created the Oceania region. We want to link Australia and New 

Zealand into this region. Right-click on Australia and select Link to Region. The 

http://www.kyokushin.nz/
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 mouse pointer will now change to a Selection Pointer. Move the pointer to the 

Oceania region and click on this region. The country of Australia will now visually be 

moved into the Oceania region. Repeat this operation for New Zealand. 

 

The Dojo Browser will now show Australia and New Zealand as geographical units of 

the Oceania region. 

 

Note: In the above example, a Region Oceania has been created, as a global region. 

Regions can be created as global regions, country regions or city regions. 

Tip: Additional to representing the real world situation, a region is also useful to 

manage security groups. 

3 . 3 . 2 .  U N L I N K  A  G E O G R A P H I C A L  U N I T  F R O M  A  R E G I O N  

To unlink a geographical unit from a region, open the Dojo Administration Form. In the 

Dojo Browser, right click on the unit you wish to unlink and select Unlink from 

Region.  

3 . 3 . 3 .  L I N K  A  G E O G R A P H I C A L  U N I T  T O  A N O T H E R  R E G I O N  

To link a geographical unit to another Region,, open the Dojo Administration Form. In 

the Dojo Browser select the unit you wish to move. Right-click on the selected unit and 

select Link to another Region. Move the Selection Pointer to the new Region and 

click on this Region. 

3 . 3 . 4 .  H I D I N G  R E G I O N S  

If you wish to disable the display of Regions in the Dojo Browser, right-click on any 

Geographical unit and select Hide Region. 

http://www.kyokushin.nz/
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4.  DOJO ADMINISTRATION 

Only a few easy steps are involved in setting up a new Dojo in KMS. 

4 . 1 .  C R E A T E  A  D O JO  

Please ensure the correct geographical location is selected in the Dojo Browser. The 

country and selected city will be pre-filled on the Dojo Details Tab. 

In the Dojo group enter all relevant fields for your Dojo. The Id field can be left blank 

and will be assigned a unique number by KMS. 

In the Contact group enter all details for your Dojo contact person, usually the Dojo 

operator. 

In the Finance group enter your bank name and account number. These details are 

only for your Dojo reference purposes and are not used in KMS. Leave all remaining 

Finance check fields unselected for now. 

Click Add to create your Dojo. 

 

 

Your Dojo will now be available in your city and when you select your Dojo all tabs will 

now be enabled. 

http://www.kyokushin.nz/
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4 . 2 .  S E T U P  T RA I N I N G  F E ES  

To set-up the training fees for your Dojo select your Dojo in the Dojo Browser and 

select the Fees tab on the Dojo Administration form. The Name column will display all 

fee types known to KMS.  

In the Fee column of the table you can select any row and change the number to the 

value that applies to your Dojo. If in the future your training fees change, select a new 

fee date in the Start Date column and change the date from which this new fee will be 

in effect. 

 

When you are finished making the changes click Update to store the new values. 

http://www.kyokushin.nz/
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4 . 3 .  S E T U P  T RA I N I N G  S C H E D U L E  

To set-up the training schedule for your Dojo select your Dojo in the Dojo Browser and 

select the Training Schedule tab on the Dojo Administration form. 

 

Enter a meaningful new Schedule Entry Name, Start Time, End Time and select a 

WeekDay for the new entry. Times must be entered in a 24 hour clock format HH:mm, 

for instance 9pm is entered as 21:00.  Tick the boxes for the targeted students. Click 

Add when satisfied with your entry. 

 

The newly scheduled class will now be displayed in the Weekly Schedule table. 

 

http://www.kyokushin.nz/
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 The scheduled entries will be displayed in interval units of 30 minutes by default. This 

interval can be changed by setting a different value in the Scheduled Interval 

textbox and click Update Settings. 

 

Add additional training schedule entries to complete your weekly schedule.  

4 . 4 .  L O A D  D O JO  LO GO  

You have the option to load your own Dojo logo, which will appear on forms and 

printouts. Open the Dojo Administration form and select the Tools menu. Next select  

Set Dojo Form Logo. 

 

Click Load from File and select the file containing the image you want to load. The 

image will appear on the form, so you can preview the result before saving it. If you 

are satisfied with the result click OK. Otherwise click Cancel to exit or you can load an 

image from a different file. 

 

http://www.kyokushin.nz/
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5. MEMBER ADMINISTRATION 

The Member Administration form can be opened by selecting Member Administration 

from the File menu. This will open a separate form from the form you are currently on.  

5 . 1 .  C R E A T E  A  M EM B E R  

On the Member Administration form select your Dojo in the Dojo Browser. If this is the 

Dojo you are usually working on, you can right-click on your Dojo and select Set as 

Default, so the next time you open the Member Administration form your current Dojo 

will automatically be selected. 

 

Provide all relevant details in the Personal Details group. The Date of Birth field must 

be entered in the format defined in your Windows Regional specifications, e.g. 

dd/mm/yyyy, 10/01/2008. 

The Membership Details group provides facilities to override the default settings for 

a new member. 

Checking the Existing Kyokushin Member will prevent a joining fee being generated. 

Checking Visitor will add the member for documentation purposes only.  

Checking Instructor indicates that the Instructor Training fees apply to this member. 

Additionally the instructor status will be indicated on the membership card. The date 

selection for the instructor indicates from which date the instructor status applies.  

The Membership Number can be left blank. The system will automatically generate a 

unique number. If a number is specified KMS will attempt to use it, providing the 

number is not already in use. 

Checking Date of birth on membership card indicates that this date must be printed 

on the membership card. 

http://www.kyokushin.nz/
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 If left blank the default Member Type is determined by the age of the new member. If 

the age is lower than 16 the default member type is Junior Member. If the age is 16 or 

higher than the default member type is Full Member. If the new member is a visitor 

the membership type is Casual Member. Other options are Family Head Member and 

Family Additional Member. A Family Head Member attracts the Family Training Fees. 

This membership type allows the member to include 1 adult member and an unlimited 

number of junior members in its membership. 

 

The Joining Grade defaults to Ungraded, but any other grade can be selected. 

A Previous Dojo can be specified. This field only has a documentary purpose. 

Click Add to create the member and store the provided information. 

The newly created member will show as the selected member in the Select Member 

box. All tabs on the Member Administration form will now be enabled.

http://www.kyokushin.nz/
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 Select the Medical Fitness tab on the Member administration form. 

 

Specify and list any medical conditions the Dojo operator and instructors need to know 

about. This information can later also be printed on the member’s grading form.  

Click Save to store the changes into the database. 

 

Select the Questionnaire tab on the Member Administration form. 

 

Specify any relevant information on this form. This information is for documentary 

purposes only. Click Save to store the changes into the database. 

 

http://www.kyokushin.nz/
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 Optionally select the Gallery tab on the Member Administration form. 

 

When a member has no member images the form will appear virtually blank. 

You can click New to load an image for the current member. A Windows file selection 

dialog will appear. Select an image file for the member and click Open. The image file 

will now be loaded and displayed on the form.  

 

If multiple images are loaded over time one of these can be marked as the default 

image. This default image will be displayed on the Member Administration form if 

image display is enabled. The default image will also be printed on the membership 

card. 

 

http://www.kyokushin.nz/
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 Note: Although any size image can be used, it is advised to reduce the image size to 

30-40 Kb before loading the image into KMS (a height of 200 pixels is OK). This will 

reduce the download time when selecting members, while still providing a good image 

for its purpose in KMS. 

http://www.kyokushin.nz/
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5 . 2 .  S U S P E N D  ME M B ER S H I P  

If a member for any reason is not able to attend classes for at least 1 month, its 

membership can be put on hold. To suspend membership open the Member 

Administration form and select the Events tab. 

 

In the Membership Suspension group check Temporarily Suspended and select the 

start date. Click Save. 

5 . 3 .  U N D O  S US P E N D E D  M E MB E R S H I P  

In the Membership Suspension group uncheck Temporarily Suspended and select the 

start date. Click Save. 

 

5 . 4 .  R E S I G N  A  M E MB E R  

In the Membership Resignation group check Resigned and select the start date. Click 

Save. 

5 . 5 .  U N D O  M E MB E R  R E S I G N A T I O N  

Retired members are not visible anymore on the Member Administration form. There 

are 2 ways to undo resignation or rejoin a member. 

Open the Member Administration form and start creating a new member, as explained 

previously. When the member’s surname and first name match a previously retired 

member, all member details will be displayed. You can now select the Events tab, 

uncheck Resigned in the Member Resignation group and click Save. 

http://www.kyokushin.nz/
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 Note: When using the KMS Presentation Client through a public network (Internet) 

performance of this method depends on the connection speed and current network 

loads. 

As the surname and first name(s) have to match exactly, in order to find a previously 

resigned member, it may be difficult to find a specific member. If this is the case you 

can use an alternative way to accomplish the task. 

Open the Dojo Administration form, select your Dojo and select the Member Info tab. 

Right-click on the MemberInfo table and select Show Resigned Members if this 

selection is not already checked. 

 

Select the member(s) you wish to unresign. Right-click on the MemberInfo table again 

and select Unretire. Right-click on the MemberInfo table and unselect Show 

Resigned Members. 

Note: This mechanism can be used to suspend, undo suspension, resign, and undo 

resignation of multiple members. But be aware that the date for the chosen action will 

be the current date. 

http://www.kyokushin.nz/
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6.  TRAINING ATTENDANCE 

Training attendance can be entered into KMS in four different ways: 

 For an individual member. 

 For a group of members. 

 Automatically through scanning the barcode on a membership card. 

 Selecting members using the Visual Class form. 

6 . 1 .  I N D I V I D UA L  T RA I N I N G  A T T EN D A N C E  E N T R Y  

On the Member Administration form select your Dojo and the member for which you 

want to add a training attendance record, then select the Training tab. 

 

In the Add Attendance group select the date for the training attendance. Now 

double-click on the required training session. This training session has now been 

added into KMS and will be shown in the Attendance History table.  

http://www.kyokushin.nz/
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The Attendance History table shows all training sessions for the selected, unless Show 

Since Last Grading Only has been checked. 

If a Training Attendance has been mistakenly added, you can right-click on this entry 

and select Remove to delete it. 

6 . 2 .  G R O U P  T RA I N I N G  A T T EN D A N C E  E N T R Y  

On the Dojo Administration form select your Dojo in the Dojo Browser and select the 

Member Info tab. 

 

Select the individual members for which an attendance entry needs to be added. 

Multiple members can be selected by holding down the Ctrl-key and clicking on 

http://www.kyokushin.nz/


 

w w w . k y o k u s h i n . n z  PAGE  26  

K
y
o

k
u

s
h

in
 M

a
n

a
g

e
m

e
n

t 
S
y
s
te

m
 member entries. A consecutive group of members can be selected from the last 

entered member to another member by holding down the Shift-key and clicking on a 

member entry. All members in between are selected. By using right-click on an already 

selected member you can unselect a member entry. 

Right-click on the table and select Add Training Attendance. The Add Member 

Training form will appear. 

 

If the training record date is not on today’s date, select the correct date and double-

click on the required entries and click Add. 

6 . 3 .  A T T E N D A N C E  EN T R Y  US I N G  A  B A R C O D E  

S C A N N E R  

Member training attendance can be added automatically by scanning the barcode on 

the back of a membership card, using a PC barcode scanner, attached to the computer. 

More on this subject will be explained later. 

If a guest student attends a session in another Dojo and scans the membership card, it 

will automatically be added to the current Dojo class attendance and to this member’s 

personal attendance records. 

http://www.kyokushin.nz/
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6 . 4 .  A T T E N D A N C E  EN T R Y  US I N G  T HE  V I S U A L  C LA S S  

From the Dojo Administration form select a Dojo. From the File menu select Visual 

Class Attendance. This will open the Visual Class Form. 

Attendance entry using this form is only accepted from 30 minutes before the first 

class until 30 minutes after the last class on the current day. To add or remove 

attendance of historical classes, select the required date first.  

 

To add a member’s attendance  to the class listed on the Class Info field click on the 

member’s name in the Available Members list. The member ’s current member photo 

will be displayed in the Visual Class. A Kanji will be displayed, if no photo is available 

for the member. 

When a member’s name is clicked when it is already listed in the Visual Class, the 

attendance will be removed from the selected class, and the member entry will be 

removed from the Visual Class. 

When a member scans it’s attendance, using the barcode on a membership card, it’s 

attendance will also be added to the Visual Class.  

http://www.kyokushin.nz/
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6 . 5 .  M O R E  O N  V I S U A L  C L A S S  O P T I O N S  

By default the Visual Class displays the current class or the first available class after 

the current time.  

6 . 5 . 1 .  A U T O M A T I C  C L A S S  C H A N G E  

When the current class ends, and the next class begins, the selected class information 

will automatically be changed. The Visual Class will be cleared and the attendance for 

the next class will be displayed. 

6 . 5 . 2 .  V I S U A L  C L A S S  B R O W S I N G  

When the attendance of a class, other than the current class, needs to be displayed, 

you can use the browse buttons at the bottom of the form. 

<< Select the first class 

< Select the previous class 

> Select the next class 

>> Select the last class 

6 . 5 . 3 .  A D D  A T T E N D A N C E  T O  A  P R I O R  C L A S S  

When a member’s attendance needs to be added to a prior class, select the required 

date and class using the Visual Class Browser mechanism and add the member by 

clicking the member entry in the Available Members list.  

6 . 5 . 4 .  R E M O V E  A T T E N D A N C E  F R O M  A  P R I O R  C L A S S  

When a member’s attendance needs to be removed from a prior class, select the 

required date and class using the Visual Class Browser mechanism and remove the 

member by clicking the member entry in the Available Members list.  
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7. FITNESS TRACKING 

7 . 1 .  S E T - U P  F I T N ES S  T E S TS  

To set-up fitness tests for your Dojo, open the Dojo Administration form and select the 

Fitness tab. 

 

To create a new fitness test, enter the name for this test in the Details group and 

indicate whether this test is a timed test or a counted test. A full test description can 

be entered to indicate the rules for this test. Click the Add button. The new test will 

now be displayed in the Available Tests table.  

The Members table will show the members that have participated in the tests. Initially 

this table will be blank. 

Repeat the above for your other Fitness Tests you want to track. 

http://www.kyokushin.nz/
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7 . 2 .  F I TN E S S  D A T A  EN T R Y  

To enter Fitness Data open the Dojo Administration form, open the File menu and 

select Fitness Data Entry, or double click on one of the available fitness tests from 

the Fitness tab. 

 

 

 

Select the Fitness Test for which you want to enter data, select the date for the test 

and select one of the Dojo members displayed in the Members table. Next enter the 

result time or count in the data entry box. 

The number of displayed members can optionally be changed by selecting or 

unselecting the Juniors or Seniors selection.  

If a result already exists for the selected test and member combination, you are able 

to update the data, or remove it, as the Add button will change into a Remove button 

if an existing result is found. 
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7 . 3 .  F I TN E S S  R ES U L T  D I S P L A Y  

To display result data online open the Dojo Administration form and select the Fitness 

tab. Select one or more tests from the Available Tests table and a member in the 

Members table. 

 

The fitness results for the selected member will be displayed in a graphical format for 

the last recorded 12 dates. 

To produce printed data output, please see the Fitness Reports section in the 

Running Reports chapter, later in this manual. 
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8.  SPECIAL EVENTS 

KMS allows special events to be created, these being events outside the normal 

training schedule. If, for example, a Dojo organizes an annual national or international 

training camp or tournament the attendance of all participants can be recorded against 

this special event. 

8 . 1 .  C R E A T E  A  S P E C I A L  E V E N T  

To create a special event open the Dojo Administration form and select the required 

Dojo in the Dojo Browser. Now select the Training Schedule tab and right-click in the 

Special Events table and select New.  

Alternatively select Create Special Attendance Event from the Tools menu. If you 

opened the form from the Training Schedule tab your Dojo will already be pre-selected. 

 

Select the required Dojo in the Dojo Browser. Select the event date and enter the 

event name, and enter the start and end time in 24 hour clock format (HH:mm). Then 

click Add. 
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The new special event will now show in the Dojo special event table.  

8 . 2 .  A D D  S P E C I A L  E VE N T  A T T E N D A N C E  

To add special event attendance open the Dojo Administration form and select the 

Member Info tab. Select the required members, right-click on the MemberInfo table 

and select Add Special Event Attendance. 

 

Select the organizing Dojo in the Dojo Browser, select the required event and click 

Add. 
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9.  GRADING ADMINISTRATION 

9 . 1 .  A D D  A  G R A D I N G  

To add grading events open the Member Administration form. Select the required 

member and select the Gradings tab. 

 

 

In the Select New Grade group select the newly achieved grade and the date of the 

grading. Optionally indicate whether the grading result was a failed or provisional 

grading. Next, click in the comments list. The comment entry form will appear. 
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 You can enter any grading comments. Click OK when done. 

When all information about the new grading result has been entered click Save to 

store the grading into the database. 

9 . 2 .  G R A D I N G  C E RT I F I CA T E  P R I N T I N G  

To print a grading certificate open the Member Administration form and select the 

required member.  

 

Select the Gradings tab. In the Select Existing Grading group select the grade you 

want to print the certificate for. To print a grading certificate you can now click Print 

Full Certificate or click Print Certificate Details if you use pre-printed certificate 

cards. 

 

Note: Before a grading certificate can be printed the certificate design must have been 

completed. 
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10.  MEMBER FINANCIAL ADMINISTRATION 

1 0 . 1 .  M E M B E RS  W I T H O U T  A U T O MA T I C  P A Y M EN T  

The simplest form of financial member administration is straight forward cash or 

cheque payment on a pre-defined term basis. Open the Member Administration form, 

select the required member and select the Finance tab. 

 

The term was defined on the Personal Details tab of a member. KMS generates invoices 

based on the payment term and type of membership. In the above example an invoice 

record is generated for a Junior member, based on a 3-month school term payment. 

Right-click on an invoice line and select Mark as Paid. The Received Date column for 

the selected line will now contain the current date as payment date. If this is not  the 

correct date, you can click on the Received Date cell of that invoice. A date-picker 

dialog will appear in which you can select the correct date. 

If an invoice has mistakenly been marked as paid, you can right-click on that invoice 

line again and select Clear Payment. 

1 0 . 1 . 1 .  S P E C I A L  T R A I N I N G  F E E  

If for any reason a member’s training fee is different from the regular training fee for 

that member type, you can specify a specify an alternate fee in the Special Financial 

Arrangements group. Set the alternate fee, the date from which this fee is applicable 

and a reason for this special arrangement. A reason, for later reference by you or 

other Dojo administrators, must be stated for the arrangement to be accepted. Click 

the Set button for this arrangement to be stored. 

To terminate a Special Financial Arrangement select the date from which this change is 

effective and click the Remove button. 

http://www.kyokushin.nz/
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1 0 . 2 .  M E M B E RS  W I T H  A U T O M A T I C  P A Y M E N T  

Members paying their training fees through an automatic payment arrangement with 

their bank can administered exactly as cash payment members, marking as paid the 

invoices as described above, based on your Dojo monthly bank account statement.       

KMS offers this payment type to be set-up slightly different, as an extra option. 

1 0 . 2 . 1 .  C R E A T E  A  M E M B E R  A U T O M A T I C  P A Y M E N T  

Open the Member Administration form, select the required member and select the 

Finance tab. In the Automatic payments group right-click on the Automatic Payments 

table and select New AutoPayment. This will open the Automatic Payment dialog. 

 

Specify the Amount of the payment, the Start Date from which this automatic 

payment will be effective and a Description. A useful description is the label for this 

automatic payment on your bank account statement, which may not necessarily be a 

good indication for which member this payment is for. (See also Automatic Payments 

report printing, later in this manual.) 

Make sure that the tick box in the End Date group remains clear, then click OK. 
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1 0 . 2 . 2 .  I N T E R N A L  A C C O U N T  V I E W  

When an automatic payment has been created and the Dojo has Automatic Payment 

handling enabled, every interval of an automatic payment the specified amount will be 

deposited into an internal account for the member. When an invoice is generated for 

the member, it will check if enough balance are available in the account to cover the 

due amount of the invoice, and withdraw this amount if available.  

To view the state of this internal amount, open the Member Administration form and 

click the Finance tab. If an internal account exists for this member, the Internal 

Account table will be displayed on the tab. 

 

The Finance tab view has been split to show both the invoices and the internal account.  
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11. DOJO FINANCIAL ADMINISTRATION 

To view all aspects of Dojo Financial Administration open the Dojo Administration form, 

select the required Dojo in the Dojo Browser and select the Dojo Finance tab. 

 

You will see an overview of all aspects of your Dojo finance. You can choose from a 

monthly or yearly overview and you can specify the Tax rate for your location, if 

applicable. 

The Financial Balance group gives you an overview of all Dojo finances in the 

selected period, showing automatically generated payments, variable revenue and 

variable expenses. 

1 1 . 1 .  C R E A T E  V A R I A B L E  R E V E N U E  

To create a variable revenue entry right-click on the Variable Revenue table and 

select Add New to open the New Revenue creation dialog. 
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 Provide a description and specify the amount and the date. You can change the tax 

rate for this entry if a special tax rate applies. Click OK. 

The new revenue will now show in the Variable Revenue table and the Financial 

Balance table. 

1 1 . 2 .  C R E A T E  V A R I A B L E  E X PE N S E  

To create a variable expense entry right-click on the Variable Expense table and 

select Add New to open the New Expense creation dialog. 

 

Provide a description and specify the amount and the date. You can change the tax 

rate for this entry if a special tax rate applies. Click OK. 

The new expense will now show in the Variable Expense table and the Financial Balance 

table. 

1 1 . 3 .  C R E A T E  A U T O MA T I C  P A Y M E N T  

To create an automatic payment entry, right-click on the Automatic Payments table 

and select Add New to open the New Automatic Payment creation dialog. 

 

Provide a description and specify the amount and the start date. You can change the 

tax rate for this entry if a special tax rate applies. Ensure the End Date is  un-checked 

and specify the payment frequency. Click OK. 

The new automatic payment will now show in the Automatic Payments table.  
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w w w . k y o k u s h i n . n z  PAGE  41  

K
y
o

k
u

s
h

in
 M

a
n

a
g

e
m

e
n

t 
S
y
s
te

m
 

1 1 . 4 .  C H A N G I N G  F I N A N C I A L  V I EW S  

The table only show limited entries in general overview mode. Even if the form is 

maximized on the computer display, it may not show everything you are interested in. 

All tables on the Dojo Finance tab can be maximized on the Dojo Finance tab by right-

clicking on the required table and selecting Maximize. 

 

The selected table will now occupy all the table space on the form. To return to normal 

view, right-click on the table again and un-check Maximize. 
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12. CERTIFICATE AND CARD DESIGN 

1 2 . 1 .  D E S I GN  K Y U  C ER T I F I C A T E  T E M PL A T E  

To design a Kyu  grading certificate open the Dojo Administration form, open the Tools 

menu and select Design Kyu Grading Certificate. 

You will start by loading a digital image of your grading certificate. This can be 

obtained by scanning a blank certificate into a digital computer image file. This image 

can now be loaded into the Kyu Certificate designer form. 

 

Click on the main area of the designer form. In the lower right corner you will see a 

table with the property values of the image. The last field in the table indicates load 

image. Click on the cell beside it and a file selection dialog will appear, in which you 

can browse your computer to find the certificate image file. 

After selecting a file the image will be displayed in the designer form. 

You will now have to move the data fields to the correct location on the form. Select 

one of the fields by clicking on it. The field properties will be displayed in the Property 

Table. To move a field click on the field, hold the mouse down and drag the field to its 

correct location. You can now release your mouse button. To fine-tune the final 

position you can select the field and use the arrow keys to move the field 1 position at 

the time 

To resize a data field move the mouse pointer close to the edge of a field. The mouse 

pointer will now change, indicating resize mode and the resize direction. Press the 
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 mouse button and drag the edge of the field into the desired direction. When done 

release the mouse button. To fine-tune the size you can select the field and use the 

Ctrl-key + arrow keys to adjust the width and height. 

 

 

For each field you are also able to change thew caption, the font, the font size and the 

font colour. Click on the white cell to change its value. For font and colour selection a 

separate selection dialog will appear to help you make a choice. 

All captions are for visual purpose during design time, except for the JUNIOR field, 

which will only be printed if the member is under the age of 16. If this field is not 

required you can set the field width and height to 0 in the Property table, which will 

make it invisible. 

The fields will be filled with the appropriate data when the certificate is printed.  

Note: All selectable fields have a single black border to visually indicate its position 

and size. These borders will not be printed on the certificate.  

Note: A certificate image has a fixed size of 731 x 1078 pixels. Images larger then this 

size are automatically downsized to fit this fixed size, but may take longer to upload 

into KMS. This depends mostly on your Internet upload speed. It is advice to reduce 

the size of your image, using a photo editing utility. 
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1 2 . 2 .  D E S I GN  D A N  C ER T I F I C A T E  T E M PL A T E  

To load and set-up a Dan Certificate open the Dojo Administration form. From the 

Tools menu select Design Dan Grading Certificate. 

The loading of the certificate image and the alignment of the text fields is exactly the 

same as described for a Kyu Certificate in the previous section.  

1 2 . 3 .  D E S I GN  M E MB E RS H I P  CA R D  T E MP L A T E  

To start designing you membership card open the Dojo Administration form. From the 

Tools menu select Design Membership Card. 

The initial form will display a sample membership design. You can select a different 

example from the Examples menu. 

 

 

This form has 4 image fields, the Card Front image, the Dojo Logo image, the Member 

Photo image and a Dan Obi image. Only the Card Front image and the Dojo Logo image 

can be loaded, the remaining image fields are populated when the card is printed.  

Additionally the form has 14 text fields, each with its own purpose. Each text field can 

be positioned and resized. It is obvious that some TextBox pairs, e.g. “Date of Birth” 

and the actual birthday, need to be positioned in a manner that they remain a pair.  

Similar for the Title field (Sosai in the example), it needs to be in a position just above 

the member name field. 

For each TextBox field the font, font size and font colour can be set. For the member 

number barcode field it is best to leave the default font.  

The Image and TextBox fields can be moved by selecting the field with the mouse 

pointer, hold down the mouse button, drag the field to its new position and release the 
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 mouse button. Fine-tune the final location by selecting the field and move the filed 

with the arrow keys on your keyboard. 

The Instructor field will be blank if the member is not marked as such in KMS. The Dan 

Obi image will only be visible for members ranked 1st Dan and up. 

Note: All selectable fields have a single black border to visually indicate its position 

and size. These borders will not be printed on the membership card. 

Note : TextBoxes have a transparent background and can overlap images, if required. 

This can be useful if the Dojo Name field needs to overlap the Dojo Logo image. 
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13. BARCODE SCANNERS 

1 3 . 1 .  S U P P O R T ED  B A RC O D E  S CA N N E RS  

At the date of writing several MetroLogic barcode scanners have been tested and used. 

To set-up MetroLogic scanners on the computer, the same utility is used for their 

complete range. 

The tested models range from current models to old 2nd hand units retrieved from a 

super-market upgrade, all with the same successful result. 

 

1 3 . 2 .  C O N F I G U R E  T H E  S C A N N E R  O N  YO U R  

C O M P U T E R  

To configure your scanner please consult your scanner manufacturer’s installation and 

user guide. 

The following is an example of what this may look like, using a Metrologic scanner, 

assuming you have already connected the scanner and tested its correct operation on 

your computer. 

Start the MetrOPOS Administrator program and create a profile for your scanner. Let 

us call this profile ‘kyokushin’, but any name will do. 

 

Next select Simple Test on the MetrOPOS sidebar. 
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Click Begin Scanner Test and present a barcode in front of the scanner. Verify that 

the correct barcode is presented on the form. 

 

Click End Scanner Test and close the MetrOPOS Administrator program. 
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1 3 . 3 .  C O N F I G U R E  A  B A R C O D E  S C A N N E R  I N  K MS  

Before configuring a scanner into KMS, first configure the scanner on your computer 

and ensure it all works correctly with the tools provided with your scanner.  

Open the Dojo Administration form, from the Scanner menu select Barcode Scanner 

Maintenance. 

 

In the Scanner Definition section provide the profile name you have previously 

created in you scanner’s administrator program. From the Scanner Type combobox 

select the scanner type. Currently only OPOSScanner is supported. Ensure the 

Default Scanner checkbox is ticked. In Data Storage select To Database and click 

the Add button. 
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1 3 . 4 .  C R E A T I N G  M E MB E R S H I P  CA R D S  

Open the Dojo Administration form, select your Dojo in the Dojo Browser and select 

the Member Info tab on the right side of the form. In the Member Info table select the 

members for which you want to print the Membership Card. 

 

Right-click on the Member Info table and select Print Member Cards. 

 

Click Selected Only, optionally set Print Preview and click OK. 

 

http://www.kyokushin.nz/


 

w w w . k y o k u s h i n . n z  PAGE  50  

K
y
o

k
u

s
h

in
 M

a
n

a
g

e
m

e
n

t 
S
y
s
te

m
 Your Membership Card(s) will now be printed. The front of the membership card is 

printed on the left section and the back of the card on the right section of the print. 

Cut out each individual membership card from the printed paper. 

Tip: A single sheet guillotine is very handy for this and these are inexpensive.  

Fold over the membership card in the centre and insert the folded card into a Credit 

Card size lamination pouch. Feed the pouch through your laminator.  

When lamination is completed, you are ready to test this card with your scanner. 

1 3 . 5 .  T E S T  A  M EM B E RS H I P  CA R D  B A RC O D E  

Open the Dojo Administration form, open the Scanner menu bar and select Barcode 

Scanner Maintenance. 

In the Existing Scanners section select your scanner from the Scanner Name 

combobox. 

 

Click Start Test Scanning and present a Kyokushin Membership Card in front of 

the barcode scanner. 
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On successful scanning all Member Information will be displayed in the Existing 

Scanner section. If the member has a member image loaded, this will also be 

displayed. 

Note: If incorrect information is displayed or no information at all after the scanner 

has beeped the scanning confirmation, please make sure that the Barcode on the 

Membership card has been printed clear and without smudges. 
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14. RUNNING REPORTS 

1 4 . 1 .  A U T O M A T I C  P A Y M E N T S  

Open the Dojo Administration form and select the required Dojo in the Dojo Browser. 

Select the Reports menu item and select Auto Payments. 

 

Selecting a date will show you all automatic payment information on that date. The 

information can be printed from the File menu item and selecting Print. 

1 4 . 2 .  C L A S S  A T T EN D A N C E  

Open the Dojo Administration form and select the required Dojo in the Dojo Browser. 

Select the Reports menu item and select Class Attendance. 
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 Selecting a date and one of the available classes on that date will show the attendance 

of this class in the Attendance table. 

 

1 4 . 3 .  F I TN E S S  R E PO RT S  

Open the Dojo Administration Form and select the required Dojo in the Dojo Browser. 

Select the Reports menu item and select Fitness Reports, or by right clicking on the 

MemberInfo tab and select Print Fitness Statistics.  

 

From the presented dialog above you can select members, age groups, type of 

reporting and set a first and last reporting date. The Selected Only option will 

automatically be selected if 2 or more members are selected on the Member Info tab.  

1 4 . 3 . 1 .  F I T N E S S  G R A P H I C A L  R E P O R T  
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 On the Fitness Report Generation Specification ensure the Graphic Report Type is 

selected. Click OK to generate the report and send it to the printer. If PrintPreview is 

selected on the Dojo Administration File menu you will be able to preview the output 

before printing starts. This report is printed in Landscape printer mode. 

 

1 4 . 3 . 2 .  F I T N E S S  T A B L E  R E P O R T  

 

On the Fitness Report Generation Specification ensure the Table Report Type is 

selected. Click OK to generate the report and send it to the printer. If PrintPreview is 

selected on the Dojo Administration File menu you will be able to preview the output 

before printing starts. 
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1 4 . 3 . 3 .  F I T N E S S  F A C T O R S  

 

On the Fitness Report Generation Specification ensure the Factors Report Type is 

selected. Click OK to generate the report and send it to the printer. If PrintPreview is 

selected on the Dojo Administration File menu you will be able to preview the output 

before printing starts. 

 

1 4 . 4 .  G R A D I N G  R ES U LT S  

Open the Dojo Administration form and select the required Dojo in the Dojo Browser. 

Select the Reports menu item and select Class Attendance. 

http://www.kyokushin.nz/
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Select the required Grading Date, select to report Senior or Junior grading results. 

By default failed grading results are not reported, but if these are required you can 

check Report Failed Gradings. Click OK. 

A report will be generated and sent to your configured Dojo Administration printer. 

1 4 . 5 .  M E M B E R  P A Y M EN T  O P T I O N S  

 

 

 

1 4 . 6 .  T R A I N I N G  H O U RS  

To report member’s training hours open the Dojo Administration form, open the 

Reports menu and select Training Hours. 
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 You are able to select a reporting date and optionally select or unselect groups of 

members. By default members which have not attended training for the past 31 days 

will not be reported. 
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1 4 . 7 .  Y E A R L Y  T R A I N I N G  H O U R S  

To print a yearly overview of training hours, open the Dojo Administration form, open 

the Reports menu and select Yearly Training Hours. 

 

Select the member type and the last date within the year, you wish to report and click 

OK. If PrintPreview is selected on the Dojo Administration File menu you will be able 

to preview the output before printing starts. 
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1 4 . 8 .  B I R T H D A Y S  

To be able to keep track of social events within the Dojo you can report upcoming 

birthdays. From the Dojo Administration form, open the Reports menu and select 

Birthdays. 

 

You are now able to select a first and last date for the period you are interested in.  
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1 4 . 9 .  T R A I N I N G  U N A TT E N D A N C E  

Just as keeping track of members activities it important to be able to keep track of 

member’s non attendance at training. This enables you to create a list of members 

which have not attended training for a minimum number of days. This minimum 

defaults to 61 days. 

 

Specify the Start Date, from which to start searching for inactive members and define 

the minimum number of inactivity days. Optionally restrict the search by unselecting 

Junior or Senior members. Click OK to start the report.  

 

A report will be printed with inactive members, similar to the sample above . 
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1 4 . 1 0 .  F E E S  A N D  T R A I N I N G  S C H ED U L E  

To print a sheet with your Dojo training schedule and training fees open the Dojo 

Administration form, open the Reports menu and select Fees and Training Schedule. 

 

Output, similar to the example above, will be sent to your printer. 

http://www.kyokushin.nz/


 

w w w . k y o k u s h i n . n z  PAGE  62  

K
y
o

k
u

s
h

in
 M

a
n

a
g

e
m

e
n

t 
S
y
s
te

m
 

15. PRINTING FORMS 

Note: If you have multiple printers and do not want to print on the default printer  for 

your computer, please ensure you have selected the correct printer in Dojo or 

Member  Administration / File / Printer Setup , prior to starting the print process. 

1 5 . 1 .  M E M B E RS H I P  F O R M S  

Membership Forms are used by new members to provide their contact details, provide 

medical information and sign the disclaimer for liability. Optionally a Questionnaire can 

be printed on the reverse side of this form. The Questionnaire could help you to find 

the most effective manner of advertising for your Dojo. 

To print Membership Forms open the Dojo Administration form, open the Forms menu 

item and select Membership Form. 

 

Membership forms provide information about your training fees. You can print 2 fee 

options side by side. The default is a yearly cash payment. The additional fee option is 

an alternative payment method, by automatic payments only.  

Enter the number of forms you want printed. Select the payment terms you require on 

your form for both the senior and junior members. The indicated training fees are the 

current training fees for your Dojo. Indicate whether you want the optional 

questionnaire printed on the reverse side. Indicate whether your printer supports 

automatic duplex (2-sided) printing. 

Click OK to start printing, or Cancel to abort the operation. 

1 5 . 2 .  G R A D I N G  F O R MS  

To print individual Member Grading forms open the Dojo Administration form and select 

the Member Info tab. Select the required members in the Member Info table, right-

click on the table and select Print Grading Sheet. 

http://www.kyokushin.nz/


 

w w w . k y o k u s h i n . n z  PAGE  63  

K
y
o

k
u

s
h

in
 M

a
n

a
g

e
m

e
n

t 
S
y
s
te

m
 

 

Select the Grading Date, optionally narrow down the member selection and indicate 

whether Grading History and / or Medical Information must be included. 

The Grading History and Medical Info will be printed on the back of the Grading Sheet.  

Optionally select the number of anonymous grading sheets you wish to print. These 

sheets do not display member name, rank or member information.  

Click OK to start printing the Grading Sheets. 

Most inexpensive printers do not have dual side printing capabilities.  

Firstly all empty anonymous sheets will be printed. Then the front side of the member 

grading sheets is printed, after which you will be prompted to turn over the printed 

member grading sheets and continue printing the information on the back. 
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1 5 . 3 .  G R A D I N G  S I GN UP  F O R M  

A grading signup form can be used for members to indicate their interest in attending 

the next grading. To print this form open the Dojo Administration form, open the 

Forms menu and select Grading Signup Form. 

 

Select the grading date and the type of grading for which to print the form, and click 

OK. 

1 5 . 4 .  E V E N T  S I G N U P  F O R M S  

An event signup form can be used for members to indicate their interest in attending a 

special event, like a Training Camp, Beach Training, Opening of a new Dojo, etc …  

 

Enter the name of the event and the date or date range for this event. Click OK to 

print the form. 
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1 5 . 5 .  M I S C E L L A N I O U S  F O R MS  

A car pooling form can be used for members to indicate available transport to a special 

event. 

 

Indicate the title and event name and the event date. Click OK to print the form. 
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16. USING EMAIL 

1 6 . 1 .  E M A I L  I N D I V I D UA L  M E M B E R  

To send an email to an individual member open the Member Administration form and 

select the member.  

 

If an email address is available in the member’s details double click the email field. 

 

This will open the KMS Email Form, with the email pre-filled. Complete the subject, ype 

your message and click send. Your message will be internally stored and sent as soon 

as the configured email server is available. 
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1 6 . 2 .   E M A I L  M U L T I P LE  M E MB E R S  

To mail multiple members open the Dojo Administration form and select the Member 

Info tab.  In the Member Info table select the required members. 

 

Right click on the Member Info table and select Email Selected Members. If none of 

the selected members have an email registered in their details, an error  message will 

be displayed to as an indication, otherwise the internal email form will be presented 

with the members pre-selected, but only those members with a registered email 

address in KMS. 

 

Complete the subject of the email and click send. 
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1 6 . 3 .  E M A I L  B RO A D C A S T  

To broadcast a message to all or groups of members, open the Dojo Administration 

Form, select your Dojo, open the Email menu and select Email Broadcast. 

 

From the dialog select the groups of members you want to send a broadcast message 

to, provide the Email Subject and click OK. 

Note: If Broadcast to Instructors is selected, only members, marked as instructor, will 

be selected. Any other specified filter criteria will be applied to the instructors only.  

1 6 . 4 .  C R E A T E  A  MA I LM E R G E  A D D R ES S  L I S T  

To create a MailMerge address list, open the Dojo Administration form, open the Email 

menu and select MailMerge Address List. 

 

From the dialog specify any geographical restrictions to your selection. Select whether 

a list is required for Dojo or Member addresses and click Generate. You will be 

prompted for the file name to save the generated list. Provide the file name and click 

Save or OK (depending on your version of Windows). 

http://www.kyokushin.nz/


 

w w w . k y o k u s h i n . n z  PAGE  69  

K
y
o

k
u

s
h

in
 M

a
n

a
g

e
m

e
n

t 
S
y
s
te

m
 

1 6 . 5 .  E M A I L  T R A I N I N G  S U M MA R Y  

To assist in a member’s query about their training hours, you can send  them the 

details of their training attendance. Open the Dojo Administration form, select your 

Dojo and select the Member Info tab. In the Member Info table select one or more 

members, right-click on the table and select Email Training Summary. Provided the 

members have a registered email address, they will be sent their training summary.  

1 6 . 6 .  E M A I L  G R A D I N G  C O MM E N T S  

To assist in a member’s query about their grading comments, you can send them the 

details of their last grading. Open the Dojo Administration form, select your Dojo and 

select the Member Info tab. In the Member Info table select one or more members, 

right-click on the table and select Email Grading Comments. Provided the members 

have a registered email address, they will be sent their grading comments. 
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17. USER PREFERENCES 

1 7 . 1 .  P R I N T E R  S E T T I N G S  

From the File menu on either the Dojo Administration or the Member Administration 

Form select Printer Setup to set your Windows printer preferences. On the same File 

menu you can select Print Preview to preview your prints. 

1 7 . 2 .  L A N G U A G E  S E T T I N G S  

From the File menu on either the Dojo Administration or the Member Administration 

form select Set Language to open the language selection dialog. 

 

Select the required display language and click OK. 

Note: At the time of writing not all forms have been translated. Any string not 

translated in the selected language will appear in the default system language 

(English). 

Note: Changing the display language does not automatically change the keyboard 

input language. This has to be done from the Windows Language bar. 

1 7 . 3 .  G E N E R A L  A P P E A R A N C E  

Each user can individualize the appearance of the system forms by setting the Skin. 

The skin setting can be invoked from several locations. 

On the System Administration, Dojo Administration or Member Administration 

form open the Settings menu and select Change Skin. 

Initially the skin selection form appears blank. 
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From the Choose Skin menu select a skin. 

 

The appearance of the selected skin will be loaded in the preview form.  If you do not 

like the selected appearance, you can choose another one. 
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When you are satisfied with your choice, click Apply. The settings will be saved and 

the appearance of your current forms will be adjusted. 
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18. TRANSLATION 

KMS has been developed in the English language. Several other display languages have 

been added and initial translations have been done using the BabelFish translation 

facility ( http://babelfish.altavista.com/tr ). These translations are usually not optimal 

for use on application forms, but hopefully give a translator good enough information 

to change these initial translations into useful short descriptions.  

Three types of translations exist within KMS. Each has their own purpose and tool to 

make translation as easy and accurate as possible. If your language is not available 

yet, please request your language to be added by email to KMS Support.  

1 8 . 1 .  F O R MS  T R A N S LA T I O N  

To start forms translation, open the Dojo Administration form, open the Translation 

menu item and select Forms Translation. 

 

In Base Locale select the language you want to translate to. In Alternate Locale you 

can optionally select another language, you may want to use as an example. If you 

select an Alternate Locale a second preview form will be displayed. You can resize the 

Forms Translation form and move the preview windows by clicking in the coloured 

caption bar and drag it to a different location. The preview windows themselves cannot 

be resized.  

If at any stage one of the preview windows or the Properties table is hidden from view 

you can bring it to the front by clicking on one of the “Bring to front” buttons.  

The Forms Browser lists all available forms within KMS. Select the form you want to 

work on and it’s current translation will be displayed in the preview window. If no 

translation exists yet for a caption on the form, it will default to English.  

http://www.kyokushin.nz/
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 For each form the Translatable Properties table will list all translatable items for 

that form. The table has three columns. The first column lists the internal name of the 

translatable item. The second column lists the default English value for the translatable 

item. The third column lists the current value for the selected Base Locale. 

Click on the item’s third cell to translate its contents. The cell will change to a TextBox 

into which you can type the value for your Base Locale. Conclude your item translation 

with the <Enter> key, or select another cell. Your new translation will now be 

displayed in the preview window, so you are able to review the complete translated 

contents before saving it. 

When you have translated all Translatable Properties click on Save to store the results. 

You can now move on to the next form. 

Click Exit when you are finished translating forms. If not all forms have been 

translated you are able to come back to it later and continue.  

1 8 . 2 .  S T R I N GS  T R A N S L A T I O N  

To start strings translation, open the Dojo Administration form, open the Translation 

menu item and select Strings Translation. 

 

In Base Locale select the language you want to translate to. In Alternate Locale you 

can select another language, you may want to use as an example. If you select an 

Alternate Locale a second read-only editor window  will be displayed. 

The Strings Browser lists all available Translatable Strings in KMS. Including the ones 

you may have already seen on the Forms Translator. Internally both the Strings and 

the Forms use the same mechanism, the difference being that many strings only 

appear as messages on a message box, on the status line or in reports. 

To translate a string select the string you want to translate in the Strings Browser. The 

current value will be displayed in the top editor window, the actual value displayed in 

red between double quotes. Change the current value by selecting the red value by 

positioning the mouse pointer at the start point of your string and drag it to the 

location where you want to end your selection. Usually this will be the complete read 
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 area between the double quotes, but does not need to be. Now start typing your 

translation. When you are done with this item, click the Save button to store your 

translation. 

You can now move on to the next translatable item you want to work on. 

Click Exit when you are finished translating strings. If not all strings have been 

translated you are able to come back to it later and continue.  

 

1 8 . 3 .  G E O G R A P H I CA L  D A T A  T R A N S L A T I O N  

Geographical data is available in KMS in many different languages, but will default to 

English if no translation is available for your selected language. Geographical data can 

be translated for your current language selecting a geographical unit in the Dojo 

Browser, right-click on the entry and select Translate Country Name or Translate 

City Name. 

 

The geographical translation dialog will be displayed with some information about your 

selected item.  
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In the yellow localized name TextBox type the name for the selected item in your 

current language. 

The new value will take effect immediately for all users. 

Note: Unlike forms captions and application strings, geographical data can only be 

translated for your current language. 

1 8 . 4 .  T R A N S L A T I O N  O F  K MS  M A N UA L S  

Please contact us by email to request a source copy of the current documentation. Your 

help will be very much appreciated. Your translation work can then be made available 

to other Dojo Operators. 

Send your request to the KMS Support and we will contact you as soon as possible. 
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19. KMS SUPPORT 

If you have any queries regarding KMS, please submit an email support request to KMS 

Support .  

1 9 . 1 .  P R O B L EM  R E PO RT S  

Queries regarding difficulties or problems in KMS will be attended with the highest 

urgency.  Please provide as much information as possible for us to try and reproduce 

the problem. 

 What was your intended action? 

 What was the nature problem of your problem? 

 Was the problem reproducible? 

 Were there any other circumstantial issues at the time the problem occurred 

(e.g. Internet connectivity problems or local workstation issues). 

1 9 . 2 .  N E W  F E A T U R E  S U G G E S T I O N S  

Please direct you request for New Feature Suggestions to the support email address. 

Queries regarding New Feature Requests will be broadcast to registered KMS users and 

will be implemented if no reasonable objections are raised. 

http://www.kyokushin.nz/
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